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„Smartphones are part of our daily life now. They're 
always with us, always on, always connected. They're 
incredibly powerful tools that have changed the way we 
interact with the world around us." - Elon Musk.



How are smartphone apps used in
education?

Language Learning Apps

•Duolingo, Babbel, and Rosetta Stone help 
students learn languages through 
interactive lessons, exercises, and games.

Flashcard Apps

•Quizlet and Anki allow students to create 
and study flashcards on a variety of subjects

Educational Games

•Kahoot!, BrainPOP, and Socrative provide 
educational games and quizzes that can be 
used in the classroom or for independent 
study

Note-Taking Apps

•Evernote and OneNote allow students to 
take and organize notes on their mobile 
devices

Reference Apps

•Wolfram Alpha, Google Scholar, and JSTOR 
provide access to a variety of resources, 
including academic articles, research papers, 
and reference materials

Productivity Apps

•Google Drive and Dropbox allow students to 
access and share documents, presentations, 
and other materials from their mobile 
devices.

Math Apps

•Photomath and MyScript Calculator allow 
students to solve math problems by taking a 
photo or writing on the screen.

E-book Apps

•Kindle and Google Play Books allow 
students to access textbooks and other 
reading materials on their mobile devices.
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Accelerometer, 
gyroscope, and heart rate 
monitor to track physical 
activity, monitor 
workouts, and record 
health data

Fitness and 
Health Apps

GPS and compass 
sensors to provide 
turn-by-turn directions, 
real-time traffic 
updates, and location-
based services

Navigation 
Apps

Camera, accelerometer, 
and gyroscope sensors 
to superimpose digital 
objects onto the real 
world

Augmented 
Reality Apps

Barometer sensors to 
detect atmospheric 
pressure and provide 
accurate weather 
forecasts

Weather 
Apps

Microphone and audio 
sensors to detect 
sound levels and adjust 
audio output 
accordingly

Music Apps

The proximity sensor 
and the camera sensor, 
to help people with 
disabilities access their 
phone's features more 
easily

Accessibility 
Apps

Use fingerprint sensors 
and facial recognition 
sensors to secure the 
phone and protect data

Security 
Apps

How are smartphone sensors used?
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This app turns your device into a sound level 
meter, detects harmful environmental noises, 
and helps protect your hearing and health.

-Microphone to detect noise levels!

-GPS and compass sensors to provide turn-by-
turn directions and location-based services.

-Camera to take pictures of the detected noise 
sources.

-Accelerometer, gyroscope, and heart rate 
monitor to track physical activity.

Noise
measuring App

How are smartphone sensors used?
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Noise pollution is a 
serious problem in 
many cities. 

Problem formulation



Noise maps

9

Noise is defined as any unwanted sound in the environment where people live and 
work, causing an uncomfortable feeling and can adversely affect health. 

The main sources of noise in outdoors are traffic, constructional and public work, 
industry, recreation, sport and entertainment. 

Noise maps are representations of the current and anticipated level of noise 
emissions at all sites within the study area depending on one particular or all 
sources of noise.

Dubrovnik, May 9th, 2023.
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• Law on Noise Protection (Official Gazette 30/09, 55/13, 153/13, 41/06 and 
114/18, 14/21) and the Ordinance on the method of preparation and content of 
noise maps and action plans as well as the methods of calculating permissible 
noise indicators (Official Gazette 75/09, 60/16 and 117/18).

• Strategic noise maps

• Action plans

Noise maps
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• Strategic noise maps - evaluates the population's exposure to traffic and industry 
noise and are made individually for road, rail, air traffic and industry, including 
associated infrastructure and facilities for sports and recreation, and especially 
facilities and areas particularly sensitive to noise (hospitals, schools, 
kindergartens, quiet areas, etc.). 

• They consist of a textual and graphic part and are used primarily as a basis for 
creating action plans and as a source of data for informing the public.

Strategic noise maps



Strategic noise map of the city of Zagreb (2018)
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Zagreb Road trafic Noise Map (day) Zagreb Road trafic Noise Map (night)

https://geoportal.zagreb.hr/Karta?tk=114

https://geoportal.zagreb.hr/Karta?tk=114
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• are made based on the results 

of the strategic noise map and 

the so-called conflicting noise 

maps, from which the 

difference between the 

existing or predicted state of 

noise immission and 

permitted noise levels is 

visible.

Action plans
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• Strategic noise maps and action plans are an integral part of the environmental 

protection information system of the Republic of Croatia and form an expert basis 

for the creation of spatial plans and in the process of strategic assessment of the 

impact of plans and programs on the environment.

• They are permanently adapted to changes in the space and must be renewed 

every five years.

• Developed strategic noise maps and adopted action plans are submitted to the 

Ministry of Health and the European Commission.

Action plans
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• Crowdsourcing is an outsourcing process that is traditionally performed by 

employees and transferred to an undefined group of people in the form of an 

open call (Howe, 2006).

• Voluntary collection of information about space or the situation in space through 

citizens represents a significant step forward in the design of management 

systems and enables the elimination of certain weaknesses of the concept of 

smart cities.

Crowdsourcing
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Smartphones have taken 

crowdsourcing to a new level.

They include many built-in sensors 

such as camera, GPS receiver, 

microphone, proximity detecting 

sensor, compass, accelerometer, 

gyroscope etc. 
https://amyingramb

log.files.wordpress.

com/2016/03/scree

n-shot-2016-02-29-

at-9-59-43-pm.png

Crowdsourcing
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Mobile phones as sound measuring
device.

Citizens measures noise exposure in 
their environment.

Participation of citizens in controlling 
noise pollution.

https://amyingramblog.files.wordpress.

com/2016/03/screen-shot-2016-02-29-

at-9-59-43-pm.png

Crowdsourcing
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Positive Negative
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Thank you for your attention!

Questions?
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Faculty of Geodesy

Teaching and research assistant
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Noise maps

Noise is defined as any unwanted sound in the environment where people live and 
work, causing an uncomfortable feeling and can adversely affect health. 

The main sources of noise in outdoors are traffic, constructional and public work, 
industry, recreation, sport and entertainment. 

Noise maps are representations of the current and anticipated level of noise 
emissions at all sites within the study area depending on one particular or all 
sources of noise.
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Using a noise level measurement application installed on mobile phone, measure 

and collect data of noise in the selected area and create a noise map based on 

this data.

Task for today
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• Spatial

component

• Time 

component

Data collection

• Sorting

• Analysis

Data processing

• Data 

classification

• Map creation

Visualization
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Android application only!

The application record:

• decibel level dB(A),

• coordinates (WGS84),

• date and time.

*The application registers the measurement every 1 second. 

Collected measurements are saved in local memory of a mobile 
phone in .JSON format. 

Noise Capture
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Before using the application for the first time, enable access to the device's 
memory, access to the microphone and location. During the measurement, the 
mobile device must have an Internet connection and location services turned on. 
Calibrate the application manually if possible.

Hold the phone in front of you pointing "away" with as little movement and shaking 
as possible.

Start walking immediately after pressing the recording icon and record for 10-15 
minutes, stop the recording, save it to the mobile device and start a new 
session/measurement.

Maintain a constant, natural walking speed during track recording. Never walk too 
fast, run or cycle with the intention of saving time.

Data collection
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1. QGIS – „professional GIS application that is built on top of and proud to be itself 
Free and Open-Source Software (FOSS)”

2. ArcGIS Online – „content management system comprised of applications and 
templates for creating interactive maps”

GIS Software for tomorow

Download QGIS Account Login - ArcGIS Online

https://qgis.org/en/site/
https://www.arcgis.com/index.html
https://qgis.org/en/site/forusers/download.html
https://www.arcgis.com/index.html
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Thank you for your attention!

Questions?

LET’S MEASURE SOME NOISE!
Dubrovnik, May 10th, 2023.
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1. QGIS – „professional GIS application that is built on top of and proud to be itself 
Free and Open-Source Software (FOSS)”

2. ArcGIS Online – „content management system comprised of applications and 
templates for creating interactive maps”

GIS Software

Download QGIS Account Login - ArcGIS Online

https://qgis.org/en/site/
https://www.arcgis.com/index.html
https://qgis.org/en/site/forusers/download.html
https://www.arcgis.com/index.html
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1. Basemap

ArcGIS Online: 

Basemap

QGIS:

Layer→Add layer→Add WMS layer
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2. Upload measurement

ArcGIS Online: 

Add →Add Layer From File

QGIS:

Layer→Add layer→AddDelimitedTextLayer
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Data downloaded in GeoJSON format needs to be converted to .shp format.

Note: If invalid measurements appear in the data set, they must be dropped before 
entering them in the program (eg no coordinates are recorded, an extremely high 
db value is recorded, etc.).

.json .shp
MERGE 
LAYERS
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Data processing

3. Classification 4. Interpolation

Spatial interpolation is the

process of using points with

known values to estimate values

at other unknown points.
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1. All values must be included within the classification.

2. Classes must not overlap, and there must not be empty classes.

3. The number of classes must be such as to maintain the accuracy with which the 
collected data provide some information.

4. If possible, the classification method should be based on some mathematical 
model.

Classification rules

The Basics of Data Classification, link

Data Classification in Mapping, link

https://www.axismaps.com/guide/data-classification
https://storymaps.arcgis.com/stories/c52d1948f04d40209fab1605ce3c8ab9
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Final result
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The described noise map was made by open-source application for the noise 
measurement, a open-source programme for data processing, and on the mobile 
device. 

The greatest advantage of the described model:

• obtained presentation offers a real and comprehensive illustration of the noise 
pollution in the area (with the reference to all noise sources),

• map can be made by engaging the community, when necessary,

• simply making general conclusions about the noise in the environment and 

• can indicate newly created environmental noise pollution. 

Conclusion
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Mobile phones as an educational tool – lot of apps using mobile senzors!

Conclusion
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Conclusion
Mobile sensors such as the accelerometer, gyroscope, and magnetometer can be used to teach physics and astronomy concepts such as 
motion, gravity, and magnetic fields. For example, students can use a smartphone app that displays data from these sensors in real-time 
to visualize the behavior of objects in motion or explore the properties of magnetic fields

GPS sensors can be used to teach geography concepts such as latitude and longitude, distance, and direction. Students can use a 
smartphone app that displays their location on a map and provides information about nearby landmarks, natural features, and 
cultural sites

Sensors such as the barometer and thermometer can be used to teach environmental science concepts such as weather 
patterns, climate change, and atmospheric pressure. Students can use a smartphone app that displays data from these 
sensors to track weather patterns, measure temperature changes, and explore the impact of human activity on the 
environment

Sensors such as the heart rate monitor and pedometer can be used to teach health and fitness concepts such as cardiovascular 
health, physical activity, and nutrition. Students can use a smartphone app that tracks their physical activity and provides 
feedback on their progress towards fitness goals

Sensors such as the camera and microphone can be used to teach engineering concepts such as signal processing, computer vision, and 
image analysis. For example, students can use a smartphone app that analyzes sound waves to study acoustic patterns or a camera app 
that uses image recognition to identify objects and patterns.

SCIENCE

GEOGRAPHY

ENVIRONMENTAL

SCIENCE

HEALTH

ENGINEERING
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